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Introduction
The Level TROLL Instrument is a compact, modular system for measuring level and temperature in natural 
groundwater, surface water, industrial waters, and other installations�

Scope

Serial number location

Certification

Unpacking and inspection

Warranty

Contact Information

This document is intended to describe the characteristics, operation, calibration, and maintenance of the 
instrument� Communication registers and SDI-12 programming information can be found in the Modbus 
and SDI-12 Reference Guides on the In-Situ website�

The serial number is engraved on the instrument housing� It is also programmed into the instrument and is 
displayed when the instrument is connected to a computer running Win-Situ Software�

Your instrument was carefully inspected before shipping� Check for any physical damage sustained 
during shipment� Notify In-Situ and file a claim with the carriers involved if there is any shipping damage� 
Accessories may be shipped separately and should also be inspected for physical damage and the fulfillment 
of your order�

See the Declarations of conformity at end of this manual�

See the product specification tables for warranty information�

Mailing and Shipping Address: 
In-Situ
221 East Lincoln Avenue
Fort Collins, CO 80524
U�S�A�
Phone: 1-970-498-1500 (international & domestic)
Fax: 1-970-498-1598
Internet: www�in-situ�com
Support: 1-800-446-7488 (U�S�A� & Canada)

Please save packing materials for future storage and shipping� The shipping boxes have been 
performance-tested and provide protection for the instrument and its accessories�
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Product Specifications
Level TROLL 400 instrument

General Level TROLL 400

Temperature ranges
Operational: -20-80° C (-4-176° F) 
Storage: -40-80° C (-40-176° F) 
Calibrated: -5-50° C (23-122° F)

Diameter 1�83 cm (0�72 in�)

Length 21�6 cm (8�5 in�)

Weight 124 g (0�27 lb)

Materials Titanium, Acetal, EPDM

Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life 3�6 V lithium; 10 years or 2M readings

External power 8-36 VDC

Memory
Data records
Data logs

2�0 MB
130,000
50

Log types Linear, Fast Linear, and Event

Fastest logging rate & Modbus rate 2 per second

Fastest SDI-12 & 4-20 mA output rate 1 per second

Real-time clock Accurate to 1 second/24-hr period

Sensor type/material Piezoresistive; titanium

Calibrated range (usable depth)

Absolute (non-vented) 
30 psia (11 m, 35 ft) 
100 psia (60 m, 197 ft) 
300 psia (200 m, 658 ft) 
500 psia (341 m, 1120 ft)

Burst pressure Max� 2x range; burst > 3x range
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Accuracy (FS) ±0�05%

Long-term stability < 0�1% FS

Resolution ±0�005% FS or better

Units of measure
Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, 
inH2O 
Level: in, ft, mm, cm, m

Temperature sensor

Accuracy & resolution ±0�1° C; 0�01° C or better

Units of measure Celsius or Fahrenheit

Warranty
3 years
Extended warranties are available for all 
instruments—call for details

Footnotes

1 Temperature range for non-freezing liquids
2 Typical battery life when used within the factory-
calibrated temperature range
3 1 data record = date/time plus 2 parameters 
logged (no wrapping) from device within the 
factory-calibrated temperature range
⁴ Across factory-calibrated pressure and 
temperature ranges� Defined as greater than 98% of 
all readings fall within spec across full temperature 
and pressure
⁵ Includes linearity and hysteresis over one year
Specifications are subject to change without notice�
Delrin is a registered trademark of E�I� du Pont de 
Nemours and Company�
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General Level TROLL 500

Temperature ranges
Operational: -20-80° C (-4-176° F) 
Storage: -40-80° C (-40-176° F) 
Calibrated: -5-50° C (23-122° F)

Diameter 1�83 cm (0�72 in�)

Length 21�6 cm (8�5 in�)

Weight 124 g (0�27 lb)

Materials Titanium, Acetal, EPDM

Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life 3�6 V lithium; 10 years or 2M readings

External power 8-36 VDC

Memory
Data records
Data logs

2�0 MB
130,000
50

Log types Linear, Fast Linear, and Event

Fastest logging rate & Modbus rate 2 per second

Fastest SDI-12 & 4-20 mA output rate 1 per second

Real-time clock Accurate to 1 second/24-hr period

Sensor type/material Piezoresistive; titanium

Calibrated range (usable depth)

Gauged (vented)
5 psig (3�5 m, 11�5 ft) 
15 psig (11 m, 35 ft)
30 psig (21 m, 69 ft) 
100 psig (70 m, 231 ft) 
300 psig (210 m, 692 ft) 
500 psig (351 m, 1153 ft)

Level TROLL 500 instrument
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Burst pressure Max� 2x range; burst > 3x range

Accuracy (FS) ±0�05%

Resolution ±0�005% FS or better

Long-term stability < 0�1% FS

Units of measure Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, 
inH2O Level: in, ft, mm, cm, m

Temperature sensor

Accuracy & resolution ±0�1° C; 0�01° C or better

Units of measure Celsius or Fahrenheit

Warranty
3 years
Extended warranties are available for all 
instruments—call for details

Footnotes See page 7�
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Level TROLL 700 instrument

General Level TROLL 700

Temperature ranges
Operational: -20-80° C (-4-176° F) 
Storage: -40-80° C (-40-176° F) 
Calibrated: -5-50° C (23-122° F)

Diameter 1�83 cm (0�72 in�)

Length 21�6 cm (8�5 in�)

Weight 124 g (0�27 lb)

Materials Titanium, Acetal, EPDM

Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life 3�6 V lithium; 10 years or 2M readings

External power 8-36 VDC

Memory
Data records
Data logs

4�0 MB
260,000
50

Log types Linear, Fast Linear, Linear Average, Event, Step 
Linear, True Logarithmic

Fastest logging rate & Modbus rate 4 per second

Fastest SDI-12 & 4-20 mA output rate 1 per second

Real-time clock Accurate to 1 second/24-hr period

Sensor type/material Piezoresistive; titanium
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Calibrated range (usable depth)

Absolute (non-vented) 
30 psia (11 m, 35 ft)
100 psia (60 m, 197 ft) 
300 psia (200 m, 658 ft) 
500 psia (341 m, 1120 ft) 
1000 psia (693 m, 2273 ft)
Gauged (vented)
5 psig (3�5 m, 11�5 ft)
15 psig (11 m, 35 ft)
30 psig (21 m, 69 ft)
100 psig (70 m, 231 ft) 
300 psig (210 m, 692 ft) 
500 psig (351 m, 1153 ft)

Burst pressure Max� 2x range; burst > 3x range

Accuracy (FS) ±0�05%

Resolution ±0�005% FS or better

Long-term stability < 0�1% FS

Units of measure
Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, 
inH2O 
Level: in, ft, mm, cm, m

Temperature sensor

Accuracy & resolution ±0�1° C; 0�01° C or better

Units of measure Celsius or Fahrenheit

Warranty
3 years
Extended warranties are available for all 
instruments—call for details

Footnotes See page 7�

111-970-498-1500 www.in-situ.com



Level TROLL 700H instrument
Comply with the Office of Surface Water by using the most accurate pressure transducer available� The Level 
TROLL 700H meets the surface-water specification of ±0�01 foot�
For accuracy under all operating conditions, instruments are calibrated over the full pressure and 
temperature range� Each instrument includes a serialized, NIST-traceable calibration report�

General Level TROLL700H

Temperature ranges
Operational: -20-80° C (-4-176° F) 
Storage: -40-80° C (-40-176° F) 
Calibrated: 0-40° C (32-104° F)

Diameter 1�83 cm (0�72 in�)

Length 21�6 cm (8�5 in�)

Weight 124 g (0�27 lb)

Materials Titanium, Acetal, EPDM

Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life 3�6 V lithium; 10 years or 2M readings

External power 8-36 VDC

Memory
Data records
Data logs

4�0 MB
260,000
50

Log types Linear, Fast Linear, Linear Average, Event, Step 
Linear, True Logarithmic

Fastest logging rate & Modbus rate 4 per second

Fastest SDI-12 & 4-20 mA output rate 1 per second

Real-time clock Accurate to 1 second/24-hr period

Pressure sensor type/material Piezoresistive; titanium

Calibrated range (usable depth) Gauged (vented) 
15 psig (11 m, 35 ft)

Burst pressure Max� 2x range; burst > 3x range

Accuracy ±0�01 foot up to 15 ft and ±0�1% of reading > 15 ft
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Resolution ±0�005% FS or better

Units of measure
Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, 
inH2O 
Level: mm, cm, m, in, ft,

Temperature sensor

Accuracy & resolution ±0�1° C; 0�01° C or better

Units of measure Celsius or Fahrenheit

Warranty
3 years
Extended warranties are available for all 
instruments—call for details

Footnotes See page 7�
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BaroTROLL instrument
The titanium BaroTROLL measures and logs barometric pressure and temperature� Use the BaroTROLL in 
conjunction with non-vented In-Situ Instruments�
Win-Situ BaroMerge Software simplifies post-correction of water level data by automatically subtracting 
barometric readings from data collected by a non-vented instrument to compensate for changes in pressure 
due to barometric fluctuations�

General BaroTROLL

Temperature ranges
Operational: -20-80° C (-4-176° F) 
Storage: -40-80° C (-40-176° F) 
Calibrated: -5-50° C (23-122° F)

Diameter 1�83 cm (0�72 in�)

Length 21�6 cm (8�5 in�)

Weight 124 g (0�27 lb)

Materials Titanium, Acetal, EPDM

Output options Modbus/RS485, SDI-12, 4-20 mA

Battery type & life 3�6 V lithium; 10 years or 2M readings

External power 8-36 VDC

Memory
Data records
Data logs

1�0 MB
65,000
2

Log types Linear

Fastest logging rate & Modbus rate 1 per minute

Fastest SDI-12 & 4-20 mA output rate 1 per second

Real-time clock Accurate to 1 second/24-hr period

Sensor type/material Piezoresistive; titanium

Calibrated range (usable depth) 30 psia (usable up to 16�5 psi, 1�14 bar)

Burst pressure Vacuum/over-pressure above 16�5 psi damages 
sensor

Accuracy @ 150 C ±0�1% FS
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Accuracy (FS) ±0�2% FS

Resolution ±0�005% FS or better

Units of measure Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, 
inH2O

Temperature sensor

Accuracy & resolution ±0�1° C; 0�01° C or better

Units of measure Celsius or Fahrenheit

Warranty
3 years
Extended warranties are available for all 
instruments—call for details

Footnotes See page 7�
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Rugged Cable system

General Rugged Cable system

Operating temperature range -25° to 80° C (-13° to 176° F)

Jacket options TPU (thermoplastic polyurethane)
Tefzel (ETFE fluoropolymer)

Vent options
Non-vented (absolute)
Vented (gauged) with desiccant (used to mitigate 
moisture/humidity)

Conductors 6 conductors, 24 AWG, polypropylene insulation

Cable diameter TPU: 6�7 mm (0�265 in�) 
Tefzel: 6�35 mm (0�25 in�)

Connector diameter 18� 5 mm (0�73 in�)

Weight

Non-vented, TPU: 16 kg/300 m (35�6 lbs/1,000 ft) 
Non-vented, Tefzel: 14 kg/300 m (32 lbs/1,000 ft) 
Vented, TPU: 14 kg/300 m (32 lbs/1,000 ft) Vented, 
Tefzel: 14 kg/300 m (32 lbs/1,000 ft)

Minimum bend radius 2X cable diameter (13�5 mm; 0�54 in�)

Break strength 127 kg (280 lbs)

Maximum cable length 1,219 m (4,000 ft) for RS485

Desiccant pack (required for vented systems) Large and extra large desiccant packs available with 
titanium, ABS, or flying leads termination�

Warranty 2 years
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Suspension wire

General Suspension wire

Material 304 stainless steel, 7 x 7 strand

Coating 15 mil polyester elastomer insulation

Weight 0�28 kg / 30 m (0�60 lb / 100 ft)

Break strength 122 kg (270 lb) with proper clip tightening

171-970-498-1500 www.in-situ.com



A pressure transducer senses changes in pressure, measured in force per square unit of surface area, exerted 
by water or other fluid on an internal media-isolated strain gauge� In-Situ offers instruments with either 
absolute (non-vented) or gauged (vented) pressure sensors�

An absolute or non-vented pressure sensor measures all pressure forces detected by the strain gauge, 
including atmospheric pressure (PATM)� The unit of measure is PSIA (pounds per square inch absolute), 
measured with respect to zero pressure� The back of an absolute pressure sensor is sealed from the 
atmosphere� Therefore, the front of the absolute pressure sensor responds to both atmospheric pressure and 
the pressure head of water above the sensor�

Absolute pressure sensor

Absolute sensor

1 Sensor back

2 Sensor front

3 Water pressure, Pw (e�g�, 20 PSI)

4 Atmospheric pressure PATM (e�g�, 14�5 PSI)

5 Vacuum

About the Pressure/Level Sensor

The “Absolute vs� Gauged: Comparing Absolute and Gauged Pressure Sensors” technical note 
describes the difference between absolute and gauged pressure sensors and explains the 

proper use of each type of sensor in different applications�
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Gauged pressure sensor

A gauged or vented pressure sensor eliminates the effects of atmospheric pressure because the vent tube 
in the cable allows atmospheric pressure to be applied to the back of the sensor� The unit of measure is PSIG 
(pounds per square inch gauge), measured with respect to atmospheric pressure�

Gauged pressure sensor

1 Sensor back

2 Sensor front

3 Water pressure, Pw (e�g�, 20 PSI)

4 Atmospheric pressure PATM (e�g�, 14�5 PSI)

5 Atmospheric pressure PATM (e�g�, 14�5 PSI)

BaroTROLL atmospheric pressure sensor

Barometric pressure applies a direct stress upon open wells and surface water� Locally, barometric effects 
can change significantly from location to location as a result of topographical and micro-meteorological 
changes� Therefore, it is important to compensate for the barometric pressure changes when monitoring 
water elevation�
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BaroTROLL sensor

1 Sensor back

2 Sensor front

3 Atmospheric pressure PATM (e�g�, 14�5 PSI)

4 Vacuum

Configuring depth and level for PLC or data logger
When you configure level using the Sensors tab, the settings are stored in the instrument and are available 
for use in Modbus, SDI-12, or 4-20 mA analog communication� A different configuration can be selected 
when you set up a log�

1� Connect the instrument to the software�

2� Click the Sensors tab�

3� Select the level/pressure sensor and click the Configure button� The Sensor Setup tab appears�

4� In the Sensor Setup window, select the level parameter, and then click Configure� The Level Setup 
Wizard opens�

5� In the Level Setup Wizard, select the options you want� For more information, view the help inside 
Win-Situ 5 software�
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System components
Instrument

Rugged Cable system

Vented or non-vented

Jacket options

Customizable cable lengths

Cable termination

The Level TROLL Instrument is completely sealed and contains no user-serviceable parts� The instrument 
includes pressure and temperature sensors, a real-time clock, microprocessor, sealed lithium battery, data 
logger, and memory� Options include a vented or non-vented pressure sensor in a variety of ranges�

Vented cable is used with vented pressure sensors to produce gauged measurements� The cable vent tube 
ensures that atmospheric pressure is applied to the back of the sensor diaphragm�
Non-vented cable is used with non-vented instruments for absolute measurements� Compensate absolute 
measurements by using a BaroTROLL Instrument and Win-Situ Baro Merge Software�

Cables can be ordered with a twist-lock termination (female connector) on both ends that connect to the 
instrument, the TROLL Com Communication Device, desiccant, and other accessories�
Cables can also be ordered with flying leads termination for wiring to a data logger or controller using SDI-
12, analog (4-20 mA), or Modbus communication protocol�

Tefzel (vented) or thermoplastic polyurethane (TPU, vented or non-vented)

Cables can be ordered up to 1,219 m (4,000 ft)�

RuggedCable Systems are custom-built, durable, direct-read cables that include the following items�
1� Titanium twist-lock connectors for quick, reliable connections to the instrument, desiccant, and 

communication cable

2� Metal shield beneath the cable jacket to prevent electrical interferences

3� Kellems grip for secure instrument deployment

4� Small desiccant for vented systems (for storage only)

Non-vented cables are marked with VF, which means vent free�

The vented cable is shipped with a small desiccant to protect against condensation� Larger 
desiccants are necessary for deployment�
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1 Rugged Cable System with female to female connectors

2 In-Situ Rugged Cable with Flying Leads with female connector

3 In-Situ Rugged Cable with Flying Leads with male connector (short length 
that converts a cable with a twist-lock connector to a flying leads cable)

Suspension wire

Polyurethane-coated stainless steel suspension cable can be used to deploy instruments with non-vented 
pressure sensors such as the Level TROLL 400 Instrument, the non-vented Level TROLL 700 Instrument, and 
the BaroTROLL Instrument� Suspension wire is appropriate to use when direct communication with the 
instrument is not necessary during deployment�

Description Part number

Suspension wire - 300 feet 0066450

Suspension wire - 150 feet 0066460

Suspension wire - 50 feet 0066470
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Communication cables

Description

The TROLL Com Communication Device provides an interface between the instrument and a desktop/laptop 
PC for calibrating and programming the instrument and for profiling and downloading data� The TROLL Com 
Communication Device is offered in either a cable-connect or direct-connect configuration including a 0�9 m 
(3 ft) vented polyurethane cable, external power input jack, and vent with replaceable membrane�

The Wireless TROLL Com enables wireless communication between a Bluetooth-enabled Android or iOS 
device and an instrument deployed on a cable� You can also use the Wireless TROLL Com as a replacement 
for a standard wired TROLL Communication Device�

1 2

3

4

5

6

7 8
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1 Dust cover for the USB connection

2

Connection status
Red (flashing) = The communication device, instrument, and Bluetooth-enabled device are not 
connected�
Red (continuous) = The communication device and instrument are connected, but the 
communication device is not connected to the Bluetooth-enabled device�
-OR- 
The communication device is connected via USB cable�
Green (flashing) = The communication device is connected to the Bluetooth-enabled device, but is 
not connected to the instrument�
Green (continuous) = The communication device, instrument, and Bluetooth-enabled device are 
connected�

3 On/Off button

4

Battery charge status:

100% - 90%

90% - 75%

75% - 50%

50% - 25%

Less than 25%

5 Cable connector to the instrument

6 Lanyard connector

7 Serial number

8 USB connection to a power source for charging the internal battery or wired connection to a 
computer

Charging the communication device
1� Remove the protective cover from the USB slot�

2� Connect the USB cable to the device�

3� Plug the USB cable into the wall charger or a powered USB port such as a computer that has a 
charger plugged in�

4� The device lights will turn on and blink according to charge level�
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Connecting to a Wireless TROLL Com

Connecting to VuSitu

Connecting to Win-Situ 5

A Wireless TROLL Com can be used to connect the instrument to software if the instrument is deployed on a 
cable�

1� Open the VuSitu Mobile App� If you have correctly paired your Wireless TROLL Com with your wireless 
device, and the instrument is available, the software will connect and display readings�

1� Turn on the Wireless TROLL Com�

2� Make sure the cable is connected to the instrument as well as the communication device�

3� Go to Bluetooth settings on your mobile device or computer�

4� From the Bluetooth section, search for devices�

5� Tap or click the serial number of the communication device to pair the device with the phone or 
computer� The serial number is located under the USB flap�

1� Open Win-Situ 5 Software�

2� When prompted, “Connect to device now?” click No�

3� Plug the USB charging cable into the computer and Wireless TROLL Com�

4� Click Preferences, then click Comm Settings�

5� Select the correct Com port used by the charging cable, then select the communication settings for 
the instrument you are connecting� The following default communication settings are most common 
for In-Situ instruments:

• Baud: 19200

• Data Bits: 8

• Parity Bits: Even

• Stop Bits: 1

• Device Address: 1

• Mode: Modbus-RTU
If you cannot connect using these settings, click the “Search for Devices” or “Reset All Devices” button�
6� Click the checkmark, then click the Connect button in the lower right hand corner�

Battery tips
A fully-charged communication device will run for up to 40-50 continuous hours�
The communication device uses an internal, rechargeable Lithium-ion (Li-ion) battery to supply power� While 
these batteries last for years with minimal decrease in performance, there are a few tips to prolong the life of 
the battery�

1� Avoid full discharges and charge the battery more often between uses�

2� Avoid storing the communication device in a high temperature (above 86° F / 30° C) area�

If the Searching screen continues to show, tap “Choose another device” and select the device 
you are trying to connect to�

251-970-498-1500 www.in-situ.com



Power options
Internal power—batteries

AC adapter

External power—external battery packs

TROLL battery pack

Internal batteries are not user-replaceable� The approximate percentage of the power remaining in an 
internal battery is displayed on the Home Screen when an instrument is connected to Win-Situ Software�
The instrument is powered by 3�6 VDC, supplied by a sealed, non-replaceable AA lithium battery� Battery life 
depends on sampling speed� The battery typically lasts for 10 years or 2,000,000 readings, whichever occurs 
first�

When an instrument is wired to a data logger or PLC controller, power to the instrument is supplied by the 
data logger or controller�

The AC adapter provides 24 VDC, 0�75 A, AC input 100-250 V and includes a North American power cord� The 
TROLL Com Communication Device includes an external power input port for connection to the AC adapter�

External battery packs can significantly increase the life of an instrument, either for long-term deployments 
or to preserve an aging instrument�

The sealed, submersible TROLL Battery Pack supplies 14�4 V� When this power source is connected, the Level 
TROLL will use the external battery source first and switch to the internal batteries when external battery 
power is depleted�

Description Part number

AC adapter 24 VDC 0052440

Description Part number

TROLL Battery Pack 0051450

0�5 second sampling interval 1�2 months

1 second sampling interval 2�3 months

1 minute (or longer) sampling interval 1 year

The sealed, submersible TROLL Battery Pack supplements internal battery power when an instrument is used 
for fast, frequent sampling or during long-term deployments� When this power source is connected, the 
instrument will use the external battery source first and switch to the internal batteries when external battery 
power is depleted� Total battery life depends on the sampling speed�

Use only In-Situ Inc�’s AC adapter� Damage to the instrument caused by the use of third-party 
converters is not covered by the warranty�
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TROLL replacement battery pack
The TROLL Replaceable Battery Pack supplements internal battery power when a Level TROLL or Aqua 
TROLL 100 or 200 Instrument is used for frequent, fast sampling or during long-term deployments� When 
this power source is connected, the TROLL instrument will use the external battery source first and switch to 
the internal batteries when external battery power is depleted� Battery life depends on sampling rate� This 
battery pack allows for 1�5 V UM-3 or size AA batteries (8) that are replaced by the user�

Description Part number

TROLL Replaceable 
Battery Pack 0090000

TROLL battery pack Level TROLL family

15 minute logging rate* 1�1 years

1 hour logging rate 1�1 years

TROLL replaceable 
battery pack Level TROLL family

15 minute logging rate* 1�6 years

1 hour logging rate 1�7 years

Estimated battery lifetime

*Logging with all sensors� Actual battery lifetime 
varies based on site conditions�

*Logging with all sensors� Actual battery lifetime 
varies based on site conditions�

The TROLL replaceable battery pack is not submersible�
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Part number Image Description

0051490 Cable Extender

Installation accessories
NPT adapter

Cable extender

The 0�25 in� NPT adapter allows instrument installation in piping�

Part number Image Description

0051470 NPT Adapter

Part number Image Description

0051480

Twist-lock 
Hanger, titanium 
for Level TROLL 
400, 700, 700H, 

BaroTROLL

Part number Image Description

0053240 Bulkhead Connector

The cable extender connects two lengths of RuggedCable System to meet varying installation needs�

Twist-lock hanger

The Twist-Lock Hanger is used with a suspension wire to install a non-vented instrument when the user does 
not require direct communication�

Bulkhead connector

The panel-mounted bulkhead connector provides connection between RuggedCable System and a 
controller panel�
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Locking well cap

Description Part number

Locking Well Cap, 2” 0020360

Locking Well Cap, 2” vented 0020370

Locking Well Cap, 4” 0020380

Locking Well Cap, 4” vented 0020390

Well dock installation ring
The well dock installation ring provides installation support for 2”, 4”, and 6” well casings�

Description Part number

Well Dock Installation Ring, 2” 0004690

Well Dock Installation Ring, 4” 0004700

Well Dock Installation Ring, 6” 0020650
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Getting started

Follow the steps below to configure and deploy the instrument�

1 Connect the instrument to a Wireless TROLL Com.

Attach the instrument’s 
twist-lock connector to 
the end of the Wireless 
TROLL Com�

Make sure the flat edges 
of the connectors align, 
and then push and twist�

You will hear a click when 
the cable is connected 
properly�

Press the power button 
on the Wireless TROLL 
Com�

clickFlat 
edge

3 Configure and deploy the instrument.

VuSitu will guide you through logging, taking readings, and configuring your instrument� Use 
the menu options to get started�

2 Connect to VuSitu

You must have the VuSitu mobile app to use the instrument with a mobile device� Download 
VuSitu from the Google Play Store or the Apple App Store�

Attach an instrument 
and turn on the Wireless 
Rugged TROLL Com� 
Launch VuSitu to 
automatically connect�

a
To connect to another 
instrument, press 
Disconnect�  VuSitu 
displays a list of available 
connections�

b
VuSitu displays the 
Connected Instrument 
screen when pairing is 
complete�

c
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Navigating VuSitu
The Level TROLL can be programmed using the VuSitu Mobile App or using Win-Situ 5 Software�

About VuSitu
VuSitu is the mobile user interface and control application for In-Situ water quality instruments� You can use 
VuSitu on mobile devices with Android operating system 4�4, Bluetooth 2�0 and newer� Download the latest 
version of the app from the Google Play Store at play�google�com�

VuSitu allows you to accomplish the following tasks�
• View live readings that update every 10 seconds

• Change parameters and units

• Set up a data log

• Record data

• Email data in spreadsheet format

• Download data to mobile device

• Transfer data from mobile device to a computer

• Organize data by Location

• Calibrate Sensors and View Reports

Connected Instrument Screen

Take single readings 
or continuously record 
live readings�

Calibrate sensors�

Access menu�

Disconnect app 
from instrument�

Access instrument 
clock and telemetry 
settings�

Access help 
information�

Configure and 
access logs on 
the instrument�
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Live Readings Screen

Snapshot Mode

Tap the button on the 
bottom left to toggle 
between snapshot and 
live readings modes�

Tap Save Single Reading 
to create a snapshot�

Tap Change Location 
in the top right corner 
if you wish to associate 
this data with a different 
location�

View the file from the 
Data Files screen�

Choose the desired 
location and press Save 
in the bottom right 
corner of the screen�

VuSitu confirms the new 
snapshot file�

Live Readings Mode

Tap the button on the 
bottom left to switch 
from snapshot mode to 
live readings mode�

Tap Start Recording� 
The instrument takes 
a reading every two 
seconds�

Tap Stop to end the 
recording� VuSitu displays 
a summary of the live 
readings data� 

Tap Save to if you wish to 
share the Live Readings 
file via email or cloud 
storage�

The live readings screen displays measurements taken from the instrument every two seconds� 
You can save these readings and share them via email or cloud storage�

321-970-498-1500 www.in-situ.com



Changing Parameters and Units

Downloading and Sharing Your Data

You can transfer a data file from your mobile device to a PC via Bluetooth, email it to yourself or 
any valid email address, or upload it to Google Drive�

VuSitu displays a 
progress bar while 
downloading�

Choose the data you wish 
to download� To save the 
entire log to your phone, 
choose All data�

Pair VuSitu with the 
instrument� Select 
Logging from the 
Connected Instrument 
screen�

Tap a log and press the 
Download button�

From the Live Readings 
screen, tap the settings 
wheel next to the 
field that contains the 
measurement value�

Tap the parameter drop-
down arrow and tap the 
parameter you want to 
display�

Tap the units drop-down 
arrow and tap the unit 
you want to display�

Tap the OK button to set 
the options and return to 
the Live Readings screen�
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Sharing Data

Viewing Data on a Mac or PC

You’ll need to extract your files to view them� To do that on a Mac, double-click the Zip folder� 
On a PC, right-click on the folder and choose Extract� Then open your files in Excel�

Select Data Files from 
the menu at the top left 
corner of the screen�

Tap and hold the name 
of the log you want to 
share�

Select Export� Choose email, cloud 
storage, or another 
sharing option�

To save data locally on your mobile device, export to a third-party file management app�
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Field deployment

1

2

Program the instrument.

Position the instrument.

In order to set up a log or download data, you must connect the instrument to a computer running 
Win-Situ 5 software or to a mobile device with the VuSitu app� See page 52�

Place the instrument at the desired depth� Position the instrument below the lowest anticipated 
water level, but not so low that the pressure sensor range might be exceeded at the highest 
anticipated water level� Refer to the tables below to determine usable depth�

A BaroTROLL Instrument can be deployed with a non-vented instrument to compensate 
level data for changes in atmospheric pressure� Make sure the clocks on both instruments are 
synchronized, and install the BaroTROLL in a location that will never be submerged in water�

Range Effective range Usable depth

PSIA PSIA kPA Meters Feet

30 15�5 106�9 11 35

100 85�5 589�5 60 197

300 285�5 1968 200 658

500 485�5 3347 341 1120

1000 985�5 6795 693 2273

Range Usable depth

PSIG kPA Meters Feet

5 34�5 3�5 11�5

15 103�4 11 35

30 206�8 21 69

100 689�5 70 231

300 2068 210 692

500 3447 351 1153

Vented Level TROLL instrument

Non-vented Level TROLL instrument
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3

4

Verify instrument depth.

Secure the cable.

After you have installed the instrument, it is possible to connect the instrument to a computer or 
mobile device, open the software, and take a reading to verify the installation position� If the reading 
confirms that the instrument is in the correct position, you can secure it as described below�

During log setup there was an option to “Remind Me Later” for setting a level reference� If you set the 
log to remind you later, ensure that the instrument is submerged and set the level reference when 
prompted�

The Rugged Cable System includes a Kellems grip near the up-hole end� You can compress the wire 
mesh and slide the grip to the desired location on the cable� Pull on the grip to tighten it on the 
cable�

Use the loop on the Kellems grip to anchor the cable to a convenient stationary object such as the In-
Situ well dock installation ring� To install the Kellems grip to the installation ring, insert the loop into 
the locking clip on the well dock and position the assembly at the top of a well casing�

1 Well Dock Installation Ring

2 Kellems Grip

3 Instrument installed in well
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5 Install the desiccant.

Vented cable must be protected with a desiccant pack that is properly sized for site conditions�

Desiccant

Installation guidelines

Desiccant protects cables, connections, and internal components from condensation, which can cause 
irreparable damage and loss of data� Indicating desiccant changes from blue to pink as it becomes saturated 
with moisture�

Desiccant stages (from left)
New, nearly expired (replace now), expired

It is extremely important to use a properly-sized desiccant for your deployment and to change desiccant 
often� Desiccant should be changed before the entire volume has turned pink, and you should use enough 
desiccant to effectively keep your equipment dry until your next scheduled maintenance� Desiccant 
longevity is dependent on site conditions and can vary from one site to the next�

• Never let the instrument fall freely down a well� Doing so will damage the sensor�

• After you have installed the instrument, verify the water level reading� Move the instrument and take 
another reading to ensure that the instrument shows reasonable change� The instrument could be 
wedged against the well casing with a loop of cable hanging below� An instrument in such a position 
could become dislodged and move while it is logging data, which would record a false change in the 
water level�

• For accurate measurements, the instrument should remain immobile while it is logging data�

• Make sure that the uphole cable end is protected� The vented cable must be protected with a 
desiccant, and the non-vented cable must be protected with a dust cap� The uphole cable end must 
be positioned above the highest anticipated water level� Avoid placing this end in a location that 
might flood�

• Do not deploy instruments in such a way that ice may form on or near the sensor or cable 
connections� Ice formation is a powerful expansive force that can over-pressurize the sensor or 
otherwise cause damage� Damage associated with ice formation is not covered by the instrument 
warranty�

• Do not allow vented cable to bend enough to obstruct the internal vent tube� The recommended 
bend radius is 13�5 mm (0�54 in), which is twice the cable diameter�
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R Bend radius 13�5 mm (0�54 in)

D Cable diameter

Stabilization time

After you have installed the instrument, allow it to stabilize to the environment for about 10 minutes before 
logging data� The T95 response time for temperature is less than 9 minutes�

A generous stabilization time is always desirable, especially in long-term deployments� Even though the 
cable is shielded, temperature stabilization, stretching, and relaxing can cause changes to readings�

If you intend to monitor water levels to the instrument’s stringent accuracy specifications, allow 
up to 60 minutes for the probe and cable to stabilize to the environment�
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BaroTROLL Instrument Installation

Installation

The BaroTROLL Instrument is designed to log barometric pressure from 0 to 16�5 PSIA (1�14 bar, 33�59 
inHg) at the surface near a submerged non-vented Level TROLL Instrument or Aqua TROLL 200 Instrument� 
BaroTROLL data may then be used to correct the water level data for barometric pressure fluctuations�

Connect the BaroTROLL to Win-Situ 5 software or the VuSitu mobile app and sync the clock� Set up a log with 
the same start time and sample interval as you set up in the non-vented level instrument� 

After the BaroTROLL Instrument is programmed, install it in a protected location above the water level near 
the submerged water level instrument� One installation configuration option is shown below using a twist-
lock hanger and a suspension wire�

To prevent flooding of the BaroTROLL electronics, attach the twist-lock hanger before you 
install the BaroTROLL� Do not submerge the Baro TROLL Instrument�

Programming the Baro TROLL instrument
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1 Atmospheric pressure + water pressure (as measured by a non-vented 
pressure sensor)

2 Atmospheric pressure (as measured by the BaroTROLL)

3 Water pressure (as measured by a vented pressure sensor, or by 
subtracting BaroTROLL data from non-vented pressure sensor data)

4 BaroTROLL Instrument (Do not submerge�)

5 Non-vented Level TROLL Instrument
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Connecting the Level TROLL to a PLC or Data Logger
The Level TROLL may be connected to a controller or logger for communication via:

• Analog 4-20 mA (provides a configurable 4-20 mA current loop output)

• SDI-12

• RS485 Modbus

• RS232 to Modbus (with a customer-supplied converter)
The flying leads cable has a female twist-lock connector on one end to connect with the Level TROLL 
instrument� The uphole end terminates in wires for connection to a PLC or data logger�

A shorter cable ending in a male twist-lock connector to connect with RuggedCable is also available�

Flying leads cable with 
female connector

Short flying leads cable 
with male connector

Rugged Cable

PLC or LoggerPLC or Logger

InstrumentInstrument

411-970-498-1500 www.in-situ.com



Desiccant
Vented cable must be installed with outboard desiccant to protect the cable 
vent tube and Level TROLL electronics from condensation in high-humidity 
environments�

The desiccant is replaceable and may be may be temporarily removed from the 
vent tube during installation�

Refer to the diagrams on the following pages for PLC wiring diagrams� Unused leads should not 
be touching�

Power

Ground

RS485 (+) RS485 (-)

SDI-12

Analog (4-
20 mA)

Flying Leads Wire Diagram

Flying Leads Cable Wire Legend

Wire Color Signal

Red External Power

Black Ground/4-20 mA Return

Blue RS485 (+)

Green RS485 (-)

White SDI-12

Brown Analog 4-20 mA Power outboard 
desiccant
connection

outboard 
desiccant

cable strap
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Redundant logging
The Level TROLL can continue recording data to a log while connected to a PLC� If the PLC or recorder loses 
data or stops recording, the Level TROLL will continue to collect data using its own internal batteries and 
clock� See the VuSitu section of this manual for more information on setting up a data log on the instrument�

Power connections

Analog (4-20 mA) wiring diagram

Communication modes

The red wire provides power for Modbus and SDI-12 communication modes� The brown wire provides 
power for analog communication� If power is present on the brown wire and not on the red wire, the device 
enters the 4-20 mA mode automatically and stays in the 4-20 mode until power is removed from the brown 
wire or is applied to the red wire� The red wire has priority� If power is applied to the red and brown wires at 
the same time, the device will operate in Modbus or SDI-12 modes but not in 4-20�

The device automatically switches between Modbus and SDI-12 modes depending on which of the two 
interfaces has activity� Modbus and SDI-12 cannot be used at the same time — whichever one is currently 
in use will block communication on the other� The 4-20 mA current loop output cannot be used at the same 
time as Modbus or SDI-12 mode� 
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SDI-12 wiring diagram
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Modbus (RS485) wiring diagram
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Modbus (RS232 with converter) wiring diagram
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Modbus PLC Interface

The Modbus PLC Interface is a simplified method of communicating with the Level TROLL using the 
Modbus protocol� For information about the specific Modbus registers and Unit IDs for your Level TROLL, 
see Appendices A and B� The Level TROLL conforms to the Modbus standard� For more information about 
Modbus communication, see www�modbus�org�

Overview

Configuring SDI-12 Settings

You can configure the list of SDI-12 parameters in VuSitu under Instrument Settings�

The Level TROLL conforms to the general SDI-12 Standard Version 1�3� For more information about SDI-
12 commands, see the SDI-12 Standard Version 1�3 document from the SDI-12 Support Group Technical 
Committee�

About SDI-12

Configure SDI-12 Settings in VuSitu

Drag and drop 
parameters to change 
the order�

Connect to VuSitu and 
select Instrument 
Settings�

Choose SDI-12 Settings� Use the checkboxes to 
select parameters to 
display�

Tap the gear icon to 
adjust the units for each 
parameter�
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Holding Register
Number

Holding Register 
Address

Size
(Registers)

Data 
Type

Description

9001 9000 1 uint16 Device Id: 
30 = Level TROLL 400
1 = Level TROLL 500
2 = Level TROLL 700/700H
3 = Baro TROLL

9002 9001 2 uint32 Serial Number

9007 9006 1 uint16 Firmware version (100 = 1�00) 

1� Connect power, and wire the instrument�
2� The setup below is using the instrument's factory default settings� Use VuSitu to reset the instrument to 
factory defaults if they have been changed� Take note of any changes in default units setup�

Setting Up Instrument

2� Set the device address match the instrument address� The default device address is 1�
3� Set the PLC to wake-up the device by sending a carriage return (0x0D) or any Modbus command�
 a� Allow one second before sending a second command� The instrument needs this time to wake up�  
 b� After the wake-up command, the next reading must be taken before the end of session timeout�  
 If the reading interval exceeds the end of session timeout, send a new wake-up  command before  
 requesting a new reading� The default end of session timeout is 5 seconds, and may be longer if the  
 instrument has been connected to VuSitu�
4�  Select the register to read on the PLC using the information in the following sections�
  a� Some PLC devices use the register number directly in programming statements, others use register
 addresses, which are one less than the register number� Refer to PLC manufacturer instructions to  
 determine which programming style to use� 
 b�  Each register is a holding register� Some PLCs require you to add 40000 to the register number or
 address� For example: 5451 would be 45451�
5�  Set the type of register to: 32-bit float
  a� If asked by the PLC this is 2 registers
6�  Set the byte order to: Big Endian (MSB)
  a� This should be the default and may not be configurable on all PLCs

1� Set up the serial communication to match the instrument communication settings� Communication 
settings can be changed with the VuSitu mobile app� The default communication settings are:

Programming the PLC

Mode Start Bit Baud Rate Data Bits Parity Stop Bit

RTU 1 19200 8 Even 1

Reading Device Information
Use the following registers to read general information about the instrument�
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Reading Parameters
Each parameter contains a block of 7 registers as shown in the table below� To read measurements for a 
specific parameter, look up the starting register for that parameter from the list of Parameter Numbers 
and Locations in Appendix A� Once you have the starting register, add the number of offset registers for 
additional information about the reading�

For example, you can apply this information to collect a reading for Pressure�

From the list in Appendix A, you can find that the starting register for Pressure is 0038� A reading from 
register number 0038 (register address 0037) will return the measured value of Pressure 

Some PLC devices use the register number directly in programming statements, others use register  
addresses� Refer to PLC manufacturer instructions to determine which programming style to use�

You can use the register offsets listed in the table above to collect additional information about the reading� 
Adding the register offset of 2 to the starting register, you can find that register number 0040 (register 
address 0039) will return the Data Quality ID for the most recent Pressure measurement� Likewise, register 
number 0041 (register address 0040) will return the Units ID, which can be interpreted from Appendix B� 
Register number 0042 (register address 0041) will return the Parameter ID, which can be interpreted from 
Appendix A� Register number 0043 (register address 0042) will return the sentinel value�

The Units ID and Sentinel Value are writable registers� Measurements can be changed to other units using 
the Units ID as shown in Appendix B� For example, if register number 0041 (Pressure Units ID) returns 17, 
Pressure is configured to report in psi� Looking at Appendix B, you can find that kPa is also a valid unit which 
can be set by writing Units ID 19 to register number 0041�

Register 
Offset

Size
(Registers)

Mode
 (R/W)

Data Type Description

0 2 R float The measured value from sensor

2 1 R uint16 Data Quality ID: 
0 = No errors or warnings
3 = Error reading parameter
For additional errors or information, contact 
technical support�

3 1 R/W uint16 Units ID for this parameter� See: Appendix B�

4 1 R uint16 Parameter ID for this parameter� See: Appendix A�

5 2 R/W float Off line sentinel value: The value that’s returned 
on error or if the parameter isn’t available� The 
default sentinel is 0�0
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Win-Situ overview
Data tab
When you open Win-Situ 5 Software, the Data tab appears� The left side of the screen contains a file tree 
where you can view previously downloaded site data as well as data you have exported to Microsoft Office 
Excel� The links on the right side of the screen show where downloaded data are stored on your computer� 
The disconnected plug icon in the lower-right corner of the screen indicates that the software is not yet 
communicating with an instrument�

Screen element Definition

The disconnected plug indicates the instrument is not communicating with the 
software� Click to establish communication with a connected instrument�
The connected plug indicates the instrument is communicating with the 
software� Click to disconnect the software from the instrument�
The Home tab displays real-time readings from the instrument� When 
connection to the instrument is first established, the software displays one 
reading of all available parameters in light gray� You must click the Play button 
at the bottom of the screen to view real-time readings�
The Logging tab displays a list of logs stored in the connected instrument� When 
you click the Logging tab, it can take a moment for the software to retrieve 
information from the instrument� (Not applicable for the RDO PRO-X and the 
Aqua TROLL 400�)
The Sensors tab lists the sensors in the connected instrument, along with their 
serial numbers and the dates of factory calibration and user calibration� Use 
the buttons in this tab to calibrate sensors that support user calibration and 
configure sensors that are supported by the instrument�
The Device Setup tab allows access to instrument information and settings such 
as instrument name, serial number, firmware version, communication settings, 
diagnostics, and factory reset options�
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Home tab
The Home tab displays real-time readings from a connected instrument� When you first establish 
communication, the software displays one reading of all available parameters�

Screen element Definition

The Sites button allows you to add, edit, or delete a site� Click the drop-down 
arrow next to the button to view the list of sites�
The Device Memory gauge turns yellow when the internal memory is used� 
Note: Non-logging instruments do not have internal memory, however, the 
gauge shows 100 percent green when power is applied�
The Device Battery gauge turns yellow as the battery is depleted� This 
example shows 80 percent of the battery remaining (green) and 20 percent 
used (yellow)� Note: Non-logging instruments do not have internal batteries, 
however, the gauge shows 100 percent green when power is applied�
The Logging Status icon:
Green—The instrument is actively logging data�
Gray—The instrument has no logs pending or running� Non-logging 
instruments always show a gray status icon�
Yellow—The instrument has log data that was collected according to specific 
instructions in the “Pending” or
“Suspended” state�
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The Alarm icon provides additional instrument status information�
Green—No alarms or warnings 
Yellow—One or more warnings 
Red—One or more alarms
Move the cursor over the alarm icon to view a description� Click the Device 
Setup tab for detailed information on the alarm or warning�
Note: Disregard the Device Reset alarm for non-logging instruments such as the 
RDO PRO Probe or the Aqua TROLL 400�
System Time is displayed on the left� Device Time is displayed on the right� 
Clocks are updated once every two seconds� When the Device Time is displayed 
in red, it differs from the current System Time, and should be synchronized�
The Time Sync button is used to write the current PC time to the instrument� If 
you need to set the instrument clock to a time other than the system (PC) time, 
use the Set Clock button on the Device Setup tab�
Meter View shows the last known parameter values, displayed with current 
units and time stamp� Readings are sized to occupy the entire screen� This is the 
default display in the Home tab� If the type is black, the readings are updating in 
real time�
List View is a running list of the most recent records� New readings are 
continuously added to the top of the list and old readings scroll off the bottom�

Graph View shows a real-time trend graph of the selected parameters�

The Snapshot button records one set of readings�

The Record button logs data to a CSV file that can be opened in a spreadsheet 
program� This is not the same as recording data in a log on the instrument�

Logging tab
The Logging tab displays a list of logs in the instrument� When you click the Logging tab, it may take a 
moment for the software to retrieve information from the instrument�
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Log information

Log status

Columns across the Logging screen show information about the logs in the instrument�

• Symbol—This is a graphic representation of the information in the Status column�

• Site—The site that was specified when the log was configured�

• Log Name—The name that was entered when the log was configured�

• Type—The logging method that was selected when the log was configured�

• Start Time—For a Pending log, the scheduled start time is shown� For a Ready log that has not yet 
started, this column displays “Manual�” For a Running or Stopped log, the actual start time is shown�

• Scheduled Stop Time—For a log with a scheduled stop, the scheduled stop time is shown� For a log 
without a scheduled stop time, this column is blank�

• Stop Time—For a Pending or Ready log, this column is blank� For a Running log, the time of the last 
data point is shown� For a Stopped log, the actual stop time is shown�

• Status—Each log has a specific status� See Log Status for details�

• Used Size—Kilobytes of instrument memory allocated for this log� For a Pending or Ready log, the 
current size of the log configuration is shown� For a Completed log, the size of the entire log file is 
shown� For a Running log, the current size of the log up to the last data point is shown�

The status of each log in the instrument is displayed in the Logging tab by a symbol beside the log name, 
and in the Status column�

Ready—Manual Start log is ready to start�

Pending—Scheduled start log is ready to start at its programmed time, or when you click the 
Start button�

Running—The log is actively logging data�

Suspended—The log has been paused (stopped temporarily)�

Stopped—The log has been stopped, either manually or on a schedule�

Deleted—The log has been marked for deletion and will be deleted from the instrument when 
memory is needed� The software manages this automatically�

Invalid—The log as programmed cannot be run�

Ready, Pending, Running, and Suspended logs are considered active� Only one log can be 
active in the instrument�
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Log control buttons

Log operations

Sensors tab

You can control the status of a log by selecting the log and clicking the appropriate button in the Logging 
tab control panel:

The Start button starts a Ready or Pending log, or resumes a Suspended log�

The Pause button pauses a Running log allowing you the option to resume it�

The Restart button restarts the selected Running log from the beginning� This can be useful during 
aquifer testing using a logarithmic data collection schedule�

The Stop button permanently stops the selected Running log�

Use the buttons in the control panel to perform the following actions:

Create a new log�

The New button is disabled if a Ready, Pending, Running, or Suspended log is on the instrument� When the 
instrument contains its maximum number of logs, the New button is unavailable�

Edit (or review) the log configuration for a Ready, Pending, or Invalid log�

Delete the log� (Note that you must delete a log twice before it is permanently removed�)

Download the log to a PC�

The Sensors tab lists the sensors in the instrument, along with their serial numbers and calibration dates� Use 
the buttons in this tab to calibrate and configure sensors�

541-970-498-1500 www.in-situ.com



Calibrate

Configure

Device setup tab

Use the Calibration button to calibrate sensors or to adjust a level reference that is currently stored on the 
instrument� The Calibrate button is not available when the instrument does not support calibration (e�g� 
BaroTROLL Instrument)�

1� With the instrument connected to the software, select the Sensors tab�

2� Select the parameter you intend to calibrate�

3� Click the Calibrate button

1� With the instrument connected to the software, select the Sensors tab�

2� Select the parameter you intend to configure�

3� Click the Configure button

Use the Configure button to select parameter units and to configure parameters that support configuration� 
Examples include Level/Depth, Specific Conductivity, and Total Dissolved Solids� Parameters cannot be 
configured while the instrument is showing live data on the Home screen or while the instrument contains 
an active log�

When you configure the Level parameter using the Sensors tab, the settings are stored in the 
instrument and are available for use in Modbus, SDI-12, or analog communication (if available)� 
If desired, a different configuration can be selected when setting up a log�

In general, you should not use the Device Setup tab unless you are corresponding with the In-Situ technical 
support team� However, you can use this screen to set up communication protocols if you are connecting 
the instrument to a PLC or data logger�
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Using Win-Situ 5 software
Connecting an Instrument to the Software

When you open Win-Situ 5 Software, you are asked if you want to connect to your device� Click Yes� 
Synchronize the instrument clock to the PC clock�
The software displays an error message if a connection cannot be established�

If you are using a USB TROLL Com, select the correct COM port by following the steps below� If you are using 
a serial TROLL Com, the Win-Situ Software should default to the correct COM port, which is usually COM 1�

Selecting the correct COM port

Steps for Windows 8�1 and Windows 10 systems�

Steps for Windows 8 systems�

Steps for Windows 7 systems�

Steps for Windows XP systems�

1� Right-click the Start button�

2� Click Device Manager�

3� Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing� The number listed 
next to this entry is your COM port address�

1� Right-click the Start screen�

2� Select All Apps�

3� Click Control Panel�

4� Open the Device Manager�

5� Click the arrow next to Ports (Com and LPT), and locate the USB Serial Port listing� The number listed 
next to this entry is your COM port address�

1� Click the Start button, and open the Control Panel�

2� Click Hardware and Sound, and open the Device Manager�

3� Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing� The number listed 
next to this entry is your COM port address�

1� Click the Start button, and open the Control Panel�

2� Double-click the System icon� Click the Hardware tab, and open the Device Manager�

3� Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port listing� The number 
listed next to this entry is your COM port address�

The following steps apply for all Windows operating systems�

1� Once you have determined the correct COM port address in your operating system, reopen Win-Situ 
5 Software�

2� Close any open windows in Win-Situ Software�

3� Click Preferences�

4� Click Comm Settings, and then click the Port Number menu�

5� Scroll down to find the correct COM port address� Click the check mark to accept the changes�

6� Click the yellow Connect button in the lower right corner to establish a connection to the instrument�
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Bluetooth & Wireless TROLL Com

Connect the cable to the Wireless TROLL Com and the Level TROLL instrument� Turn on the Wireless TROLL 
Com and open Win-Situ 5� Choose File > Connect to access the Default Communication Settings window�

Select the radio button labeled Bluetooth Communications and click Configure Bluetooth Devices� You will 
see a list of nearby Bluetooth devices� Click the Wireless TROLL Com you are using and click the check mark�

Finally, click the yellow Connect button at the bottom right of the screen to complete the connection�

Setting the instrument time

The instrument time and the current PC time are shown at the top of the screen when an instrument is 
connected to the software�

The PC time appears on the left, the instrument time on the right� Both clocks are updated at 0�5 Hz (once 
every two seconds)� The device time is displayed in red if it differs by more than a few seconds from the 
current PC time� Data logging schedules depend on a correct instrument time�
To synchronize the instrument time to the current PC time, click the Clock Sync button Win-Situ writes the 
current PC time to the instrument�
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Adding a new site

Log setup

To add a new site to the site database in your working directory do one of the following:
On the Data tab, click the Site Data folder, select File> New > Site�
or
On the Home tab, click the Site button to display the site list, then click New � Enter a name for the site� This is 
the only required field�
Click Save to save the new site� The new site will appear in the Site Data folder, and Win-Situ will add it to the 
site database in the working directory on your computer� It is now available to select for any instrument log�

The Log Setup Wizard presents sequential screens to help you supply all the information necessary to set up 
a data log in the instrument�

To access the Log Setup Wizard the instrument must be connected to the software�

1� Click the Logging tab� 

2� Click the New button�  

3� Select the Site where the set of data will be logged and supply a name for the log� 

4� Click the right arrow to continue after each step� 

5� Select the parameters you intend to measure, choose the measurement units, and specify the 

order in which the selected parameters will be logged� 

6� Select the logging method you intend to use� 

7� Select the log interval� A log interval is how often a measurement will be taken and stored� 

8� Select the start condition, stop condition, and specify how to handle full device memory� 

9� If you selected Level or Depth as a parameter to measure, specify how you intend to log this 

parameter� 

10� The final screen summarizes the log setup� Click the check mark to write this information to the 

instrument� 

Logging method descriptions

Logging methods for long-term monitoring

Linear

The following is a list of log types and their descriptions� The log types that are available on an instrument 
vary depending upon the capabilities of the instrument�

Linear log type measures and records at a user-defined fixed interval of one minute or more� 
This method is used for long-term studies, landfill monitoring, stream gauging, tidal studies, and 
background monitoring prior to aquifer testing� Intervals are measured in days, hours, or minutes�
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Linear Average

Event

True Logarithmic

Fast Linear

Step Linear

Linear Average log type can smooth out anomalous highs and lows that may occur in a data set, for 
example, when a water wave passes over the instrument� Each stored measurement is the average 
of several rapid measurements� This method is used for long-term studies, stream gauging, tidal and 
open-water studies where trends are more important than accuracy� Intervals are measured in days, 
hours, minutes, or seconds�

Linear Event log type combines basic fixed-interval logging of specified parameters with the ability 
to log data at a faster interval when a single-parameter event condition is present�

True Logarithmic log type captures early-time water-level data during aquifer testing� Measurements 
are very closely spaced at the start of the test (4 measurements per second) and move further apart 
on a logarithmically decaying schedule as the test progresses� There are 40 measurements per log 
decade� This log type is commonly used for rapid step-drawdown pump tests, constant-rate pump 
tests, and slug tests�

Fast Linear log type measures and records at a user-defined fixed interval of one minute or less� The 
interval is small
(seconds, milliseconds), and the test is usually of short duration due to the volume of data logged 
and the impact of very fast sampling on battery life�

Step Linear log type measures and records data according to a number of user-defined elapsed 
time intervals or “steps” within a schedule� Both the elapsed time and the number of measurements 
within each step can vary� After completing the elapsed time for each step, the schedule will 
automatically move to the next step� Up to 10 separate steps can be defined�

Logging methods for long-term monitoring

About the level reference

A Level Reference, also called an offset, is a user-specified starting point for logged Level readings� 
Depth mode does not require that you enter a Level Reference�
The Level Reference can be any value you choose� Here are some examples:

• Elevation—If you calculate the water level above mean sea level (MSL) and enter this as the 
Level Reference, then elevations above MSL will be logged�

• Depth to Water—If you measure the depth to the water surface (DTW) from the top of the 
well casing and enter this as the Level Reference, then DTW (also called drawdown) values 
will be logged�

• Zero—A Level Reference of 0 effectively sets the probe to zero at the start of the log� 
Changes, both positive and negative, from the starting water level, will be logged�

• New Reference—This option is designed to be used with an active software connection 
when the device is installed in the water�

Once you have determined the value of your Level Reference, the software gives you three options for 
entering it� These control when the level reference is applied�
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A new level reference must be entered while the device’s pressure sensor is submerged in its 
final position in the water� This is because the current probe reading is set equal to the Level 
Reference to create the offset that takes effect at the start of the data log� The log header will 
show the probe reading at the time you entered the Level Reference�

During log setup, the software presents two additional options for entering the Level Reference:

• Set first logged reading—Use this option when the instrument will be deployed on wire rather than 
cable because you will not be able to communicate with the instrument when it is submerged�

• Remind me to set reference later—Use this option to defer the entry of the Level Reference during 
log setup and set a reminder to enter it when the device is submerged in its final position�

Starting a log
Every log is programmed for either a manual or a scheduled start� A log with a manual start time is displayed 
in the Logging screen with Ready in the Status column� A log with a scheduled start time is displayed with 
Pending in the Status column�

Starting a Pending Log

Starting a manual log

Suspending (pausing) a log

Resuming a suspended log

A Pending log automatically starts at the scheduled time without any user intervention�

A running log may be temporarily paused� For example, you might want to reposition an instrument, 
calibrate a sensor, or clean a sensor and later resume the log� A log can be suspended and resumed 
three times�

A scheduled log with Pending status can be manually started at any time before its scheduled 
start�

1� With the instrument connected to the software, select the Logging tab� 

2� Select the Ready log you want to start�

3� Click the Start Log button� The log starts and the symbol changes� The Status column displays 
Running�

1� With the instrument connected to the software, select the Logging tab�

2� Select the log you intend to suspend�

3� Click the Suspend button� Suspended appears in the Status column�

1� To resume logging after a log has been suspended, select the Logging tab�

2� Select the Suspended log�

3� Click the Start Log button� Logging resumes� Running appears in the Status column� The data file 
will show the time when the log was suspended and the time when it restarted�

Stopping a log
A log can be manually stopped at any time, even if a stop time has been previously scheduled� If you did not 
specify a stop condition when you defined the log, the log will run until the instrument is out of memory or 
battery power, or until you manually stop it�
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A log that has been stopped cannot be resumed� If you intend to resume a log later, you should 
suspend a log rather than stop it�

1� To manually stop a log, the instrument must be connected to the software�

2� Select the Logging tab�

3� Select the running log you intend to stop�

4� Click the Stop Log button�

Downloading data to a PC

This procedure copies the data log from the instrument to a PC� It does not remove the data log from 
the instrument� After a log is downloaded, it can be exported to a CSV file format that can be used by 
spreadsheet programs� The time shown in the log name is the time the log was downloaded�

1� With an instrument connected, select the Logging tab

2� Select the log you intend to download�

3� Choose a Running, Suspended, Stopped, or Deleted log�

4� Click the Download button�

5� In the next screen, select one of the three download options�

• All data

• New data (data logged since the last download)

• Time interval to download

New data is downloaded by default to a new log file� To append new data to the last download 
of this log, be sure the option “Append logs on download” is selected in the General Settings 

dialog (Preferences > General Settings)�

1� The log is copied to the connected PC into your Win-Situ working directory folder� View or change 
the working directory using File > Settings�

2� At the end of the download, Win-Situ gives you the option of viewing the data�

3� Select Yes and the log is displayed in the Data screen�

4� Select No and the Logging screen appears� You can view the data at any time by selecting it in the 
Data tab�

Viewing logged data

1� To view the data stored in the instrument, you must first download the data� A connection to an 
instrument is not needed after the data log has been downloaded�

2� Select the Data tab�

3� On the left side of the screen, select the log you want to view� To expand a folder shown in the 
navigation tree, double-click the folder� The content of the data log is displayed on the right side of 
the screen in text or graph format�
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To switch between view formats, click the Text or the Graph button in the control panel� To 
customize the text or graph view, select Preferences > Graph Settings or Preferences > Data 

View Settings� These options apply to all downloaded data until you change the options�

Importing VuSitu data to Win-Situ

You can import data files from VuSitu into Win-Situ 5 from the File menu�

Click File > Import VuSitu CSV in the menu bar at the 
top of the screen�

Select the file you wish to import and click Open�

Select OK at the prompt� Click on the file name to view it�
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Using BaroMerge software
BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to eliminate barometric 
pressure effects from the measurements� BaroMerge Software can be accessed through the Win-Situ 5 
Software Tools menu� BaroMerge provides three options to correct data�

• Fixed Correction—A single offset value is applied to all selected log data� Use this option if you 
know the barometric pressure of the site during the log, and know that it did not change�

• Manual Entry—Specify two or more correction values to apply to the log data� Use this option if 
you wish to manually enter a data set of barometric pressure values�

• BaroTROLL log file—Absolute level sensor data points are individually corrected to reflect 
barometric pressure changes that were logged by a BaroTROLL instrument during the 
approximate time period�
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BaroMerge input—BaroTROLL file

Log files that contain absolute data can be barometrically compensated using values logged by the In-
Situ Inc� BaroTROLL Instrument� Select this method when you have access to a BaroTROLL log file covering 
approximately the same time period as the data file you intend to correct�
To use this correction method, you need the name of the BaroTROLL log file and the name(s) of the absolute 
log file(s) you want to correct�

1� From the Tools menu in Win-Situ 5 Software, select Win-Situ BaroMerge�

2� Select the “Use a BaroTROLL file:” option�

3� Click the browse button to the right of the file field�

4� Select a BaroTROLL file and click the check mark�

5� Values from the BaroTROLL file will be displayed in the next window� You can edit these values if 
necessary�

6� Click the right arrow button�

7� Select the log file(s) you intend to correct and click the check mark�

8� Compensated data files can be viewed or exported from the Data tab�

BaroMerge output

Your original log file is not changed� A new, corrected log file with the same name and path is created� The 
original “�wsl” extension is replaced by “-Baro Merge�wsl”�

Disconnecting an instrument from the software

Click the plug icon in the lower-right corner of the screen to disconnect the instrument from the software� 
Disconnect the instrument from the communication device� Attach a desiccant pack if you are using a 
vented cable�

641-970-498-1500 www.in-situ.com



Cleaning & maintenance
Overview

Operating considerations

Temperature

Pressure range

Batteries

It is important for users to perform scheduled maintenance on their instruments to sustain the accuracy and 
longevity of the probes and cables� The frequency of this maintenance depends on the characteristics of the 
deployment site, including humidity levels and the degree of fouling�
Users should be aware of the conditions at their deployment sites and develop appropriate maintenance 
schedules to replace desiccant, clean the instruments, and send in the instruments for factory calibration� 
Users should check instruments often during the first portion of the deployment to determine the frequency 
of maintenance� General maintenance should be performed as often as possible� Factory maintenance and 
calibration should be performed every 12 to 18 months�

The instrument has been designed to withstand harsh field conditions� However, as with any electronic 
instrument, it can be permanently damaged if used outside its operating specifications�

Review the instrument specifications to determine the operating range� Do not deploy instruments in such 
a way that ice may form on or near the sensors or cable connections� Ice formation is a powerful expansive 
force that can over-pressurize the sensor or otherwise cause damage that is not covered by the warranty�

The instrument can withstand pressures of up to two times (2X) the rated range of the pressure sensor 
without damage, although it may not read correctly at such pressure� If the pressure range is exceeded by 
3X, the sensor will be destroyed�

Internal batteries in the instrument are not user-replaceable� The approximate percentage remaining is 
displayed in Win-Situ software or the Vu-Situ mobile app when the instrument is connected�
If batteries are completely exhausted, external power and battery pack options are available� See page 24�
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Desiccant pack options
Small desiccant

Large and extra large desiccant

Desiccant refill kit

Outboard Desiccant

The Small Desiccant is a disposable cap that ships with In-Situ products� The small desiccant is meant to 
protect the instrument and cable only during shipping and should not be used for deployments�

The Large and Extra-Large Desiccant are used to protect equipment deployed in the field� The Large 
Desiccant is best suited for low-humidity environments or deployments where maintenance occurs 
regularly� The Extra-Large Desiccant is designed for high-humidity environments or deployments where 
maintenance occurs infrequently� Extra-Large Desiccants provide six times the drying capability of the Large 
Desiccant� When the desiccant expires, both can be refilled with fresh desiccant and re-used (see Desiccant 
Refill Kit below)� The Large Desiccant is available with an ABS or a titanium twist-lock connector, while the 
Extra Large Desiccant uses a titanium connector only�

Description Part number

Large desiccant, titanium 0051810

Large desiccant, ABS 0053550

Extra large desiccant 0090420

Description Part number

Desiccant refill kit 0029140

Description Part number

Outboard Desiccant 0051380

The Desiccant Refill Kit supplies desiccant for the Large Desiccant, Extra Large Desiccant, and the Outboard 
Desiccant� It also contains replacement glass wool�

The Outboard Desiccant is a replaceable desiccant pack designed to attach to the vent tube of the flying 
leads�
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Installing desiccant with Twist-lock connectors

Installing outboard desiccant

1� Remove the protective dust cap from the bottom of the desiccant pack, if applicable�

2� Remove expiring desiccant (if present) from the cable by grasping the textured section of the cable 
connector in one hand and the desiccant in the other� Twist in opposite directions to unlock the 
desiccant from the cable�

3� Attach the new desiccant pack to the twist-lock connector on the cable�

Vented cable must be installed with outboard desiccant to protect the cable and instrument electronics 
from condensation in high-humidity environments�
The desiccant can be removed from the vent tube, if necessary, to trim the conductor wires� However, you 
must reinstall the desiccant after trimming and connecting the wires�

1� Cut off the knot at the bottom of the vent tube extension�

2� Firmly attach the vent tube extension to the cable vent tube� Cover at least 6�4 mm (0�25 in�) of the 
cable vent tube for a secure attachment�

3� Use the attached hook-and-loop strap to secure the desiccant to the cable�

4� Remove the red dust cap from the black nylon cap to allow air to reach the cable’s vent tube�

1 Outboard desiccant is attached to the cable 
vent tube�

2 Desiccant is secured to the cable with a strap�

1

2
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Using the desiccant refill kit
1� Remove the black nylon vent cap from the top of the desiccant�

2� Pour out and discard the used desiccant� Check the glass wool in the bottom of the container and 
replace if necessary�

3� Fill the container with fresh desiccant� Replace the vent cap� Reattach to cable if removed�

The glass wool prevents the desiccant beads from falling out the cable end of the desiccant 
pack� If the wool glass does this effectively, there is no need to replace it when refilling the 
desiccant�

Antifouling

O-ring inspection and replacement

TROLL shield nose cone

The copper TROLL Shield Nose Cone is designed to reduce macro- and micro-fouling of the pressure sensor 
on Level TROLL and Aqua TROLL Instruments� Reduced fouling on the sensor improves measurement 
accuracy and extends the length of deployments�
For optimum performance, the TROLL Shield Nose Cone should be replaced every 12 months or sooner if 
site conditions are extremely harsh�

Description Part number

TROLL shield nose cone 0081480

Examine O-rings for wear, dryness, discoloration, stretching, cracks, nicks, and brittleness� Replace O-rings 
when any of these conditions are present� Replacing O-rings on an annual basis, regardless of their 
condition, is the best way to protect against moisture damage�
Perform the following steps to replace an O-ring�

1� Remove and discard the damaged O-ring�

2� Use a clean, dry, soft cloth to clean the O-ring groove to remove dirt or residue�

3� Lubricate the new O-ring using high-vacuum grease�

a� Wash your hands thoroughly�

b� Apply a small amount of grease to the pad of your index finger, and rub your index finger and 
thumb

c� together to spread the grease evenly�

d� Inspect the new O-ring and remove any debris stuck to it�

4� Rub your fingers around the O-ring until there is a thin layer of grease on the entire O-ring�

5� Install the O-ring in the groove and remove any excess lubricant with a clean cloth�

Do not allow water or lubricant to enter the connector�
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Cleaning the instrument

Twist-lock connectors

Storage

Clean the instrument body with water and a soft brush or plastic scouring pad, or soak overnight in a mild 
acidic solution, such as household vinegar� NEVER submerge the connector portion of the instrument when 
it is not connected to a cable�
If the ports near the pressure sensor are clogged with silt or mud, try the following procedures�

Do not attempt to remove material from the instrument by tapping the instrument against a surface� 
To avoid damage to the pressure sensor diaphragm, do not insert any object into the sensor opening or 
attempt to dig out dirt or other materials� You void the instrument’s warranty by inserting anything into the 
sensor opening� If contamination cannot be removed using the recommendations above, please contact In-
Situ for cleaning�

• Agitate the instrument vigorously in a bucket of clean water�

• Apply a gentle rinse of water from a wash bottle�

• In severe cases, remove the nose cone and clean out the holes with a soft brush or pipe cleaner�

Do not insert ANY object into the sensor opening� Doing so voids the warranty�

Keep the pins on all connectors free of dirt and moisture by using the soft protective dust caps when cable is 
not attached�

Level TROLL Instruments—store within the temperature range -40° C to +80° C (-40° F to 176° F)

Store the instrument in a clean, dry place� Place the protective red dust cap on the cable end or store with 
cable attached to protect the connector pins and O-ring� For vented cables, ensure the desiccant used is the 
appropriate size and change it when needed� Store the instrument where it will not roll off a bench onto a 
hard surface or sustain other mechanical shock� Protect the instrument from temperature extremes using 
the following guidelines:
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Factory calibration and service
In-house factory calibration

Return Materials Authorization (RMA) Form

Obtaining repair service

Outside the US

Factory calibration of In-Situ instruments should be performed every 12 to 18 months, or at any point when 
the data appears to drift significantly� Factory calibration includes a thorough cleaning, all operational 
checks, necessary firmware upgrades, O-ring replacement, and full range calibrations of the pressure sensor, 
temperature sensor, and conductivity sensor (when applicable)�

To obtain a factory calibration, fill out and return the online Return Materials Authorization (RMA) form 
located at www�in-situ�com/�

If you suspect your system is malfunctioning and repair is needed, you can help assure efficient servicing by 
following these guidelines:

1� Call or email In-Situ Technical Support� Have the product model and serial number available�

2� Be prepared to describe the problem, including how the product was used and the conditions noted 
at the time of the malfunction�

3� If Technical Support determines that service is needed, they will ask your company to fill out the RMA 
form and pre-approve a specified monetary amount for repair charges� When the form and pre-
approval is received, Technical Support will assign an RMA (Return Material Authorization) number�

4� Clean the product as described in the manual�

5� If the product contains a removable battery, remove and retain it unless you are returning the system 
for a refund or Technical Support states otherwise�

6� Carefully pack your product in its original shipping box, if possible�

7� Mark the RMA number clearly on the outside of the box�

8� Send the package, shipping prepaid, to:

In-Situ
ATTN: Repairs
221 East Lincoln Avenue
Fort Collins, CO 80524

The warranty does not cover damage during transit� In-Situ recommends insurance for all shipments� 
Warranty repairs will be shipped back prepaid�

Contact your international In-Situ distributor for repair and service information�
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Guidelines for cleaning returned equipment
Please help us protect the health and safety of our employees by cleaning and decontaminating 
equipment that has been subjected to potential biological or health hazards, and labeling such equipment� 
Unfortunately, we cannot service your equipment without such notification� Please complete and 
sign the form on page 78 (or a similar statement certifying that the equipment has been cleaned and 
decontaminated) and send it to us with each instrument�

• We recommend the glassware cleaning product, Alconox, available from In-Situ and from laboratory 
supply companies�

• Clean all cables and remove all foreign matter�

• Clean the cable connectors with a clean, dry cloth� Do not submerge the connectors�

• Clean the instrument including the nosecone, cable head, and protective caps�

If an instrument is returned to our Service Center for repair or recalibration without a 
statement that it has been cleaned and decontaminated, or if it is the opinion of our Service 
Representatives that the equipment presents a potential health or biological hazard, we 
reserve the right to withhold service until proper certification is obtained�

Decontamination & cleaning statement
Company Name Phone

Address

City State

Instrument Type Serial Number

Contaminant(s) if known)

Decontamination procedure(s) used

Cleaning verified by Title

Date


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Troubleshooting
In addition to the following troubleshooting items, the In-Situ website includes instructional videos, 
technical notes, and more� See www�help�in-situ�com�

Problem Possible cause Solution

Win-Situ 5 Software cannot 
connect to the instrument�

Wrong COM port is selected, 
communication settings are 
incompatible, cable connections 
are loose or dirty, or batteries are 
low�

Make sure cable connections are 
tight and connectors are clean 
and dry�
Make sure the cable is securely 
attached to the instrument�
Make sure the correct COM port 
is selected (select Preferences > 
Comm Settings to verify)�
Make sure the communication 
settings in Win-Situ and in the 
instrument match� To reset the 
device communication settings 
to the serial defaults, click “Reset 
all Devices” in the Comm Settings 
dialog (Preferences > Comm 
Settings)�
Make sure the internal battery has 
voltage remaining, or external 
power is supplied�
See www�in-situ�com/
Technical_notes and scroll to the 
Communications and Software 
Technical Notes section for more 
information�

Real-time readings display the 
wrong units� Default units are being used�

Click the Sensors tab, select the 
sensor, click the configure button 
and select the desired units for 
each parameter in the Sensor 
Setup window�

Cannot add a new log�

Only one active log can reside in 
the device at a time—an active 
log is a log that is Ready, Pending, 
Running, or Suspended as shown 
in the Status column of the 
Logging Tab�
The device has its maximum 
number of logs already stored—
the Level TROLL 300, 500, and 
Baro TROLL have a capacity of 2 
logs�

Stop or delete the log if possible� 
Alternatively, configure the 
new log after the active log is 
completed�
Download, and then delete a 
log you no longer need� This will 
make room for an additional log 
on the device�
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New log exceeds available 
memory (software message)�

The log as configured would 
exceed the device memory�

Edit the log and select a longer 
sampling interval�
If available, select the “wrap data” 
option� This causes more recent 
data to overwrite older data when 
memory is full�
For a log with a scheduled start, 
select None as the stop condition, 
or select a stop time that is closer 
to the start time�

Cannot configure level or other 
parameters using the Configure 
button on the Sensors tab� The 
Sensor Setup screen is shown, but 
the Configure��� button is dim�

The instrument is actively polling
(continually updating real-time 
readings) in the Home tab�
The instrument has an active 
log—a log that is Ready, Pending, 
Running, or Suspended as shown 
in the Status column of the 
Logging tab� Only one active log 
can reside in the device at a time�

Return to the Home tab and stop 
real-time readings by clicking the 
Play button�

Stop or delete the log if 
possible� Alternatively, configure 
parameters after the log is 
complete�
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Declarations of Conformity and Similarity
Level TROLL 400

 

 

  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: Level TROLL 400 
Model: Level TROLL 400 
Part Numbers: 0099240, 0099250, 0099260, 0099270 
Product Description: The Level TROLL 400 is a sensor used to measure and log the depth of water. 
Model Variants: Variants of the Level TROLL 400 include sensors which are Gauged (vented) which are 
denoted with a “G” and Actual (non-vented) which are denoted with an “A”.  The numerical values indicate 
the maximum pressure range.  These are the model variants: 5 PSIG, 15 PSIG, 30 PSIG, 100 PSIG, 300 
PSIG, 500 PSIG, 30 PSIA, 100 PSIA, 300 PSIA, 500 PSIA. 
 
These are in compliance with the following Directives: 

 
 2014/30/EU EMC Directive 
 2014/35/EU Low-Voltage Directive 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meet or exceed the following international requirements and compliance standards: 

EMC Standard: 
  EN 61326-1:2021 
 Safety Standard: 
  EN 61010-1:2010 + A1:2019 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 
David A. Bossie                
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: Level TROLL 400 
Model: Level TROLL 400 
Part Numbers: 0099240, 0099250, 0099260, 0099270 
Product Description: The Level TROLL 400 is a sensor used to measure and log the depth of water. 
Model Variants: Variants of the Level TROLL 400 include sensors which are Gauged (vented) which are 
denoted with a “G” and Actual (non-vented) which are denoted with an “A”.  The numerical values indicate 
the maximum pressure range.  These are the model variants: 5 PSIG, 15 PSIG, 30 PSIG, 100 PSIG, 300 
PSIG, 500 PSIG, 30 PSIA, 100 PSIA, 300 PSIA, 500 PSIA. 

These products are in compliance with the following Regulations: 
 

 EMC Regulation 2016 
 Electrical Equipment (Safety) Regulation 2016 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Regulation (S.I. 2012:3032) 

and meet or exceed the following British requirements and compliance standards: 
 

 EMC Standard: BS 61326:2021 
 Safety Standard: BS EN 61010-1:2010 + A1:2019 
 RoHS: BS 63000:2018 

 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: Level TROLL 500 
Model: Level TROLL 500 
Part Numbers: 0089000, 0089010, 0089020, 0089030, 0089040, 0089050 
Product Description: The Level TROLL 500 is a sensor used to measure and log the depth of water. 
Model Variants: Variants of the Level TROLL 400 include sensors which are Gauged (vented) which are 
denoted with a “G” and Actual (non-vented) which are denoted with an “A”.  The numerical values indicate 
the maximum pressure range.  These are the model variants: 5 PSIG, 15 PSIG, 30 PSIG, 100 PSIG, 300 
PSIG, 500 PSIG, 30 PSIA, 100 PSIA, 300 PSIA, 500 PSIA. 
 
These are in compliance with the following Directives: 

 
 2014/30/EU EMC Directive 
 2014/35/EU Low-Voltage Directive 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meet or exceed the following international requirements and compliance standards: 

EMC Standard: 
  EN 61326-1:2021 
 Safety Standard: 
  EN 61010-1:2010 + A1:2019 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 
David A. Bossie                
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: Level TROLL 500 
Model: Level TROLL 500 
Part Numbers: 0089000, 0089010, 0089020, 0089030, 0089040, 0089050 
Product Description: The Level TROLL 500 is a sensor used to measure and log the depth of water. 
Model Variants: Variants of the Level TROLL 400 include sensors which are Gauged (vented) which are 
denoted with a “G” and Actual (non-vented) which are denoted with an “A”.  The numerical values indicate 
the maximum pressure range.  These are the model variants: 5 PSIG, 15 PSIG, 30 PSIG, 100 PSIG, 300 
PSIG, 500 PSIG, 30 PSIA, 100 PSIA, 300 PSIA, 500 PSIA. 

These products are in compliance with the following Regulations: 
 

 EMC Regulation 2016 
 Electrical Equipment (Safety) Regulation 2016 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Regulation (S.I. 2012:3032) 

and meet or exceed the following British requirements and compliance standards: 
 

 EMC Standard: BS 61326:2021 
 Safety Standard: BS EN 61010-1:2010 + A1:2019 
 RoHS: BS 63000:2018 

 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that the following product: 
Product name: Level TROLL 700 
Model: Level TROLL 700 
Part Number(s): 0089110, 0089120, 0089130, 0089140, 0089150, 0089160, 0089550 
Product Description: The Level TROLL 700 is a sensor used to measure and log the depth of water. 
Model Variants: Variants of the Level TROLL 700 include sensors which are Gauged (vented) which are 
denoted with a “G” and Actual (non-vented) which are denoted with an “A”.  The numerical values indicate 
the maximum pressure range.  These are the model variants: 5 PSIG, 15 PSIG, 30 PSIG, 100 PSIG, 300 
PSIG, 500 PSIG, 30 PSIA, 100 PSIA, 300 PSIA, 500 PSIA, 1000 PSIA.  
 
is in compliance with the following Directive 

 2014/30/EU EMC Directive 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meets or exceeds the following international requirements and compliance standards: 

EMC Standards: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 

David A. Bossie                    
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

We declare that the performance of the following product: 
Product name: Level TROLL 700 
Model: Level TROLL 700 
Part Number(s): 0089110, 0089120, 0089130, 0089140, 0089150, 0089160, 0089550 
Product Description: The Level TROLL 700 is a sensor used to measure and log the depth of water. 
Model Variants: Variants of the Level TROLL 700 include sensors which are Gauged (vented) which are 
denoted with a “G” and Actual (non-vented) which are denoted with an “A”.  The numerical values indicate 
the maximum pressure range.  These are the model variants: 5 PSIG, 15 PSIG, 30 PSIG, 100 PSIG, 300 
PSIG, 500 PSIG, 30 PSIA, 100 PSIA, 300 PSIA, 500 PSIA. 
 
is in compliance with the following Regulations: 

 EMC Regulation 2016 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Regulation (S.I. 2012:3032) 

and meets or exceeds the following British requirements and compliance standards: 
 

 EMC: BS 61326-1:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: Baro TROLL 
Model: Baro TROLL 
Part Number: 0089100 
Product Description: Barometric pressure Data Logger 
Model Variants: None 

This is in compliance with the following Directives: 

 
 2014/30/EU EMC Directive 

 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meets or exceeds the following international requirements and compliance standards: 

EMC Standard: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 
David A. Bossie                
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: Baro TROLL 
Model: Baro TROLL 
Part Number: 0089100 
Product Description: Barometric pressure Data Logger 
Model Variants: None 
 

This is in compliance with the following Regulations: 
 

 EMC Regulation 2016 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Regulation (S.I. 2012:3032) 

and meets or exceeds the following British requirements and compliance standards: 
 

 EMC Standard: BS 61326:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 

811-970-498-1500 www.in-situ.com
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: TROLL Battery Pack 
Model: TROLL Battery Pack 
Part Number: 0051450 
Product Description: This product provides power to the Level TROLL products in the event their internal 
batteries are depleted. 
Model Variants: None 

This is in compliance with the following Directives: 

 
 2014/30/EU EMC Directive 

 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meets or exceeds the following international requirements and compliance standards: 

EMC Standard: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 
David A. Bossie                
Regulatory Compliance Manager              
In-Situ, Inc. 
July 13, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Level TROLL 700 : 
Product name: TROLL Battery Pack 
Model: TROLL Battery Pack 
Part Number: 0051450 
Product Description: This product provides power to the Level TROLL products in the event their internal 
batteries are depleted. 
Model Variants: None 

This product is in compliance with the following Regulations: 
 

 EMC Regulation 2016 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Regulation (S.I. 2012:3032) 

and meets or exceeds the following British requirements and compliance standards: 
 

 EMC Standard: BS 61326:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 13, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that the following product: 
Product name: TROLL Com 
Model: TROLL Com 
Part Number(s): 0052500, 0052510 
Product Description: The TROLL Com is used to connect a water quality sensor to the laptop computer to 
monitor results or to set up and download a log. 
Model Variants: The TROLL Com models vary by the type of connection through which the product connects 
to the sensor.  The TROLL Com is available with a Direct connection or twist-lock connection. 

is in compliance with the following Directive 
 2014/30/EU EMC Directive 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meets or exceeds the following international requirements and compliance standards: 

EMC Standards: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 

David A. Bossie                    
Regulatory Compliance Manager              
In-Situ, Inc. 
July 13, 2022 

 

841-970-498-1500 www.in-situ.com



 

 

  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

We declare that the performance of the following product: 
Product name: TROLL Com 
Model: TROLL Com 
Part Number(s): 0052500, 0052510 
Product Description: The TROLL Com is used to connect a water quality sensor to the laptop computer to 
monitor results or to set up and download a log. 
Model Variants: The TROLL Com models vary by the type of connection through which the product connects 
to the sensor.  The TROLL Com is available with a Direct connection or twist-lock connection. 
 
is in compliance with the following Regulations: 

 EMC Regulation 2016 
 Restriction of the use of certain hazardous substances in electrical and electronic 

equipment (RoHS) Regulation (S.I. 2012:3032) 

and meets or exceeds the following British requirements and compliance standards: 
 

 EMC: BS 61326-1:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 13, 2022 
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Appendix 
Appendix A: Parameter Numbers and Locations

ID Parameter Name Holding Register 
Number

Holding Register 
Address Default Units

1 Temperature 0046 0045 1 = °C

2 Pressure 0038 0037 17 = PSI

3 Depth 0054 0053 38 = feet

4
Level, Depth to 
Water
(Enable with VuSitu)

0054 0053 38 = feet

5
Level, Surface 
Elevation
(Enable with VuSitu)

0054 0053 38 = feet

1-970-498-1500 www.in-situ.com
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Appendix B: Unit IDs
ID Abbreviation Units

1 C Celsius

2 F Fahrenheit

Pressure, Barometric Pressure (17-32)

17 PSI Pounds per square inch

19 kPa Kilopascals

20 Bar Bars

21 mBar Millibars

22 mmHg Millimeters of Mercury (0 to C)

23 inHg Inches of Mercury (4 to C)

24 cmH2O Centimeters of water (4 to C)

25 inH2O Inches of water (4 to C)

Distance/Length (33-48)

33 mm Millimeters

34 cm Centimeters

35 m Meters

37 in Inches

38 ft Feet

1-970-498-1500 www.in-situ.com
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